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Chapter 1:  Overview
This is the ContactWise QuickStart Program Advanced Manual.  As was discussed in the Basic Manual, Contact-
Wise is a Customer Relationship Management (CRM) application.  The ultimate purpose of ContactWise CRM is 
to help you save time, stay organized, and effectively help you manage business-critical information.  

The Basic Manual covered aspects such as:  contact management (contact creation, contact edit, contact his-
tory summary, etc.), group management (public and private groups of database contacts), and event manage-
ment (scheduling phone calls and appointments).  The following subjects will be discussed throughout the 
course of this Advanced Manual.

•     Opportunity Management

             o     Schedule action items for your sales pipeline
	 o     Keep track of any process or instance with a customer and/or organization

•     Marketing

	 o     Create and send mass emails to a group of contacts
	 o     Perform mail merges with Microsoft Word or WordPerfect

•     Call Lists

	 o     Create call lists of your contacts

•     Report Generation

	 o     Generate a report based on group, filter, or opportunity criteria
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Chapter 2:  Opportunities
2.1  Opportunities Overview
The Opportunities feature provides users with the ability to track multiple opportunities (or instances/transac-
tions) per person or organization contact.  
Opportunities are typically used in a sales organization and can be used to track:

		  sales pipelines				   opportunity status	        sales forecasting
		  account representative activities	 probabilities
		  correspondence per deal 		  amount closed

Because of the flexibility ContactWise offers, opportunities have been used in various organizational applica-
tions, from bill tracking for Legislative organizations to project management and campaigns. 

The information that can be tracked in an opportunity includes:

     •   Opportunity Status
     •   Products being sold
     •   Estimated completion date
     •   Associate assigned to the opportunity
     •   Custom property fields
     •   Opportunity history
     •   Opportunity events

   2.1.1  Opportunity Types and Templates
   All opportunities are associated with a type and a template.  The best way to think of how types and tem-     		
   plates relate is to consider a type to be a “category” and a template to be a “category option.”  For example,      	
   you could consider the United States of America to be a type and each of the 50 states to be a template.  One           	
   type can have many templates that can be chosen as its category option.  The system administrator can cre-		
   ate as many types and/or templates as it deems necessary for organizational needs.  

   2.1.2  Opportunity Tracking
   The opportunities feature provides users with the ability to track multiple opportunities per person or organi-   	
   zation contact. Information that can be tracked includes:
     
     •   The source of an opportunity
     •   The value (dollar amount) of an opportunity
     •   Whether or not an opportunity status has matured to completion (ie: a sale)
     •   Opportunity history of correspondence by email and phone with the contact or organization
     •   Opportunity History notes
     •   Appointments and tasks – both scheduled and assigned
     •   Property fields (configured by the database administrator)

2.2  Viewing and Accessing Opportunities
Accessing opportunities in ContactWise can be done in several different ways, including all opportunities in the 
database and opportunities for a specific contact or organization.
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   2.2.1  Opportunity Tab
   The primary opportunity tab is located between the “Groups and Filters” and “Call Lists” tabs.  Once you have
   clicked on the Opportunity tab, you should see your opportunity filter template to the left, the main grid in    	   	
   the center, and the opportunity extended view to the right.  If there are any existing opportunities that have 		
   been created by yourself or someone else in your organization, you will see them in the main grid.  

   If you are new to opportunities and this is a first time use for you or your organization you will not see any  		
   opportunities listed in the main grid (Figure 2.1).

Figure 2.1

   Figure 2.2 illustrates an example of an opportunity tab that already has opportunities stored in the database.
   You will notice there is an icon  on the far left of each listed opportunity.  This icon indicates this is an op-
   portunity.

   You will also notice the following fields displayed in the main grid of the opportunity tab:

        •   Display Name
        •   Organization
        •   Type
        •   Template
        •   (Opportunity) Status

Figure 2.2
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   Just as is the case on the Contacts tab, you can choose to filter and/or sort opportunities by selecting the 		
   “sort” box.  Figure 2.3 shows the various options that can selected to narrow down the result list.

Figure 2.3

   You will also notice in Figure 2.2 that there is a box displayed as “Show Completed Opportunities.”  Once an    	
   opportunity status has been selected as “complete” it will no longer display in the primary opportunity tab.
   However, if you do wish to view all completed opportunities you may select this box and they will be dis- 		
   played.

   The opportunity filter functions the same as the filter in the main Contacts tab (Figure 2.4).

Figure 2.4

   These fields are configured by the database administrator, but you have the option to quickly narrow down 
   the result list to the specific information you are looking for.  This filter template does not correspond to the 
   filter template in the primary Contacts tab.

   2.2.2  Contact or Organization Opportunity
   To open an opportunity or view all opportunities associated with a specific contact or organization you can:

        1.  Double click on an opportunity from the opportunity tab (Figure 2.5).
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Figure 2.5

        2.  Open a contact record and select the Opportunity tab (Figure 2.6).

Figure 2.6

   After accessing the opportunity tab for an individual contact or organization, the screen in Figure 2.7 will ap-		
   pear.  If you have not created an opportunity for this contact, everything will be blank.
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Figure 2.7

   The top of the opportunity tab displays the

        •    key to create a new opportunity

        •    key to delete a selected opportunity

        •   Date field range 
        •   Option to show completed opportunities in the display  

   Below the top part of the opportunity tab is the display field of all listed opportunities.  This field shows:

        •   Opportunity Type
        •   Opportunity Template
        •   Opportunity Status
        •   Status Changed (Date)
        •   ID (gives a unique identifier to each opportunity; the system automatically generates this number)
        •   Amount Discussed  (dollar amount)
        •   Amount Closed (dollar amount collected)
        •   Creation Date (creation date of the specified opportunity
        •   Modified Date (date the opportunity was last modified)
        •   Submitted By (internal user that submitted the opportunity or made the last modification)
        •   Account Number (number the system generates automatically for an invoice if an invoice system is 
	 used)

   Note that the top tab is used for display only.
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   On the left, under “Type-Status” you will notice the following fields:

        •   Amount Discussed
        •   Amount Closed
        •   Status
        •   Est Completion Date (Estimated completion date of the sale or status)

   The system administrator may have also set up customer property tabs to allow you to have additional capa-		
   bilities to record information about an opportunity (Figure 2.7).

   In the mid-right section of the Contact or Organization Opportunity screen is horizontal list of actions that 		
   can be taken for each opportunity (Figure 2.8).  The icons for each action, in order, are:

        1.  Open Original Email:  This will link to the first email associated with that opportunity.
        2.  Remove Selected Opportunity History:  This action will delete any history made for a desired opportu-		
	 nity.
        3.  Refresh Opportunity History:  This will refresh the history of a desired opportunity to see if any recent                          	
             changes have been made.
        4.  Send Email:  Allows you to send an email in relation to an opportunity.
        5.  Add History Note:  Allows you to insert a note for an opportunity so that it may appear in its history.
        6.  The remaining actions create generic history notes and appointments.  They are as follows:  Receive a 	                	
	 Phone Call, Placed a Phone Call, Schedule an Appointment, Schedule a Task, Assign an Appointment,   	
	 and Assign a Task. 

Figure 2.8

   You should see your opportunity filter template to the left, the main grid in the center, and the opportunity    		
   extended view to the right.  If there are existing opportunities that have been created by yourself or some-
   one else in your organization, you will see them in the main grid. 
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Figure 2.9

   Once an opportunity has been entered, the bottom left portion of the screen will fill with Opportunity
   Properties that are set by the database administrator to further document the opportunity. You have already
   learned how to create an organization in the ContactWise QuickStart Program – Basic Manual. Once you
   have created an organization, open that organization’s contact record by double clicking on it. You will notice
   the primary tabs discussed previously (Name, Phone & Address, Properties, History, Events, Members, and
   Groups) (Figure 2.9).

   The status of an opportunity is displayed in the columns of both the main Opportunity Tab and the Contact 
   or Organization Opportunity Tab.  The status can be changed by clicking on it in the left side of the Contact or 
   Organization page.

   Using the Database Administrator Tool, a status field can be selected and assigned a certain number of days    
   that may pass before the opportunity will appear on the grid, highlighted in a color selected by the user (Fig-
   ure 2.10).
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Figure 2.10

2.3  Opportunity Creation

When creating an opportunity, it is important to consider your workflows and how you are using opportunities. 
For example, a sales organization may create opportunities under the organization they are working with as 
opposed to a person at that company. The reason is one or more sales representatives may have multiple op-
portunities with a single organization. Using an example in the state or local government sector, a senator may 
want to track constituent stances on a particular piece of legislation. The senator in this instance would create 
an opportunity for the person since the constituent is not tied to any particular organization. Remember that 
opportunities can only be created when you are in a Contact’s page in the “Opportunity” Tab.

   2.3.1  Opportunity Filter Templates
   The quick filter in the opportunity tab works much like the Quick Filter in the Contact tab. There are only two 
   differences:

        1.  It finds opportunities instead of Contacts
        2.  The filter templates are independent of those in the Contact tab

   Filter Templates are created in the ContactWise Database Administrator.

   To use the Quick Filter, first select the desired template.  Fill out some or all of the fields in the template and    	
   click the Search button. The filter will find opportunities that meet all the criteria you ask for.

   An asterisk can be used as a wild card in searches. The asterisk is used to represent any one or more char-
   acters. For example, if the names “Mike” and “Michael” exist in the database in a particular field then “Mi*” 
   would find both of them.
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   2.3.2  Opportunity Extended View
   When an opportunity is selected in the main grid, information pertaining to that opportunity is displayed in 
   the extended view. There are five sections of information that can be displayed in the extended view. Three 
   are displayed by default: Opportunity Details, Opportunity Properties, and Opportunity History (Figure 2.11).    
   The other two, Opportunity Owner Phone and Opportunity Owner Address, can be turned on in ContactWise 
   Options under Tools in the tool bar.

Figure 2.11

   2.3.3  Opportunity Property Fields 
   Property information associated with the opportunity is set by the administrator and appears in the bottom 
   left-hand corner of the Contact or Organization screen when an opportunity is selected (Figure 2.12).

Figure 2.12
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   2.3.4  Deleting an Opportunity

   An opportunity is deleted by selecting an opportunity and then clicking the  icon.  Opportunities may also 
   be deleted from the main Opportunity Grid by right-clicking on the opportunity and selecting “Delete Select-
   ed Opportunities.”
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Chapter 3:  Advanced Filter
In this chapter, you will learn the advantages of using advanced filters as well as how to run them. The topics 
discussed include:

     •   The phone and address filter
     •   Advanced database filtering
     •   Boolean search logic
     •   Understanding filter results

3.1  Phone and Address Filter
The phone and address filter allows you to create a comprehensive filter for the phone numbers and addresses 
of people and organizations.  

To perform a Phone/Address Filter in ContactWise:

     •   Open the Filters menu and select New Phone/Address Filter (Figure 3.1).
     •   Select what will be filtered—Person, Organization, or All
     •   Apply desired operators to all search fields, including:  Phone Description, Country Code, Area Code, 
          Phone, Ext, Address Description, Address, City, State, Postal Code, Country, Email, and Website.  Then 
          enter text information that applies to your operators for each field you desire to search.
     •   Click Search to apply your filter and bring up the Filter Screen (Figure 3.3).

Figure 3.1
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3.2 Advanced Database Filtering
Advanced filtering is set up to allow just about everything in ContactWise to be compared.  It can pull from 
property tabs, history, address, phone, and first/last/full/organization names, creation date, and brief notes.  It 
also allows for grouping and one level of parentheses.

To perform an advanced search in ContactWise:

     •   Select New Advanced Filter under the Filters menu (Figure 3.2).
     •   Select the Contact Filter—All Contacts, Person, or Organization.  Choosing Person or Organization will 		
          narrow the search to that type of contact.
     •   Select an output option: Contacts, Opportunities, or Members.
     •   Click on the adjacent menu drop down arrow to select the areas of ContactWise to search.
     •   Select an operator
     •   Select End to add more lines to the search, or expand the search criteria by using AND, OR, or END 
          GROUP statements.
     •   Click on Search
     •   Important Notes:

          o   Because of the flexibility of the advanced filter it is easy to create a search that does not have anything		
	   in it.  For example:  (Area Code=801 AND Area Code=802).  Since nobody can have two area codes for 		
	   the same phone number, an empty set is returned.
          o   Searching for the subject or body of a history item is a case-sensitive search.  The body of a history 		
	   item is referred to as a note in Advanced Filters.

Figure 3.2

As soon as the contents are submitted, the Advanced Filter’s results will appear in a new screen.  Figure 3.3 
shows the results of a filter where the first name of “John” was filtered.
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Figure 3.3

3.3 Boolean Search Logic
The ContactWise search filter can be effectively broadened to incorporate more desired results by using 
Boolean Logic. This includes options such as AND as well as OR. For example, if you wanted to create a filter 
that contained everyone whose first names started with “J” and everyone whose names started with “L,” you 
would:

     •   Select the First Name Search Option
     •   Select the Begins with Operator
     •   Put the letter “J” in the text field
     •   Change the Line Options from End to Or
     •   Use the same settings for the second line, using the letter “L” and End for the Line Option

These settings are displayed in Figure 3.4 with the results in Figure 3.5.

Figure 3.4
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Figure 3.5

3.4 Understanding Filter Results
The information of each result is displayed at the right when it is clicked on. From this screen, you can use the 
menu bar for more options.

     •   Clicking on File will allow you to create another filter, edit your current filter, export it into another for-
          mat, save it, mark it as private, or delete it.
     •   View will allow you to refresh your filter to see if any new results might be added into the list.
     •   Email gives you options for emailing the filter.
     •   Print gives you options for printing the filter.
     •   Tools allows you to Copy Group to Group as well as Copy to a Call List.
     •   Help will bring up the help files to answer questions about the filter or its results.

Many of these options also appear under the menu bar, including buttons for creating a New Filter, Saving your 
Filter, Editing your Filter, and Refreshing it. There is also a button that allows you to select the Filter’s Output, 
which means it allows you to pick the Contacts, Opportunities, and Members that meet your search criteria.
Next to Current Filter is a drop down bar that allows you to pick from saved filters, and below that is another 
drop down bar that allows you to sort your results (Figure 3.6).
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Figure 3.6
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Chapter 4:  Extended View Setup & View Options
This chapter will go into detail about the Extended View feature and the different options it provides in the fol-
lowing sections:

     •   Accessing & understanding Extended View options
     •   Contact options
     •   Opportunity options

4.1 Accessing & Understanding Extended View Options
Extended view is a panel on the right side of the screen that shows a brief summary of a contact or opportuni-
ty when it is clicked on.  The options for Extended View can be customized by clicking on the Tools menu then 
Options (Figure 4.1).

Figure 4.1

As shown in Figure 4.1, Extended View must be clicked in the sidebar to access its options. Contact and Oppor-
tunities will expand from Extended View because both of those uses Extended View respectively.

4.2 Contact Options
As seen in Figure 4.1, the information that Extended View presents can be edited. The options for the Contact 
page allow you to select which types of information will be presented and what order they come in. Below the 

ordering buttons is a Restore to Default button  to set the types back into their original order.
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You can also select which properties appear in Extended View by selecting Search for Properties by Property 
Name, or by Tabs, which can associate many properties with one tab. The checkboxes are used to indicate 
when a property has been selected; if the box is checked, it will appear in Extended View when saved.

At the bottom of the screen there are options to Cancel your adjustments to Extended View, Save them, or re-
store them to Default. Click on Help to answer any questions you may have about Extended View adjustments.

After you have saved your options, the Extended View for a contact in the Contacts Tab will appear when you 
click on that contact (Figure 4.2). 

Figure 4.2

4.3 Opportunity Options
The Opportunity Options page works the same as the Contact Options page. You can choose the types of infor-
mation shown and the order in which they are shown. You can also select the Search for Properties by options. 
These options work with the checkbox and save system. One unique attribute found on the Opportunity Op-
tions page is the Opportunity Histories selection (Figure 4.3).

Figure 4.3
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The Opportunity Histories option allows you to select how many histories will appear in the Opportunity Ex-
tended
View.

After all the options have been saved, the Extended View for an opportunity in the Opportunity Tab will appear 
when you click on that opportunity (Figure 4.4).

Figure 4.4
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Chapter 5:  Email
This chapter discusses both GroupWise and Outlook email clients, beginning with Groupwise. If you are using 
the Outlook client, go directly to section 5.5.

In this chapter, you will learn how to do the following:

     •   Attach contact records to an email message
     •   Send an email message to multiple contacts
     •   Send an email message to multiple addresses of a contact
     •   Change the primary email address
     •   Insert multiple email addresses into a contact or company record
     •   Mass email

5.1 GROUPWISE - Attaching Links to an Email Message
When an email message is sent to another GroupWise user who has access to your ContactWise database, you 
can send a link from which the contact record can be opened. Contact links within an email message are only 
saved with Intranet email messages. If the email is sent to an Internet email address, the link to the record is 
lost. Below is a list of steps to link a contact to an email message:

     •   Highlight a contact and click on the email button at the top of the ContactWise screen (Figure 5.1).

Figure 5.1

     •   Select the Use the ContactWise Mail Dialog radio button in the ContactWise Email dialog and click OK.
     •   Select Add ContactWise Links from the Contact Links menu (Figure 5.2a). This will open the Select a 
          Contact dialog (Figure 5.2b).
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Figure 5.2a

Figure 5.2b

     •   Select a contact and click OK.
     •   Click Send to send the email message.

5.2 Emailing Messages to Multiple Contacts
NOTE: This topic only applies when GroupWise is being used as the collaboration client.

Email can be sent to multiple contacts through the ContactWise email dialog by following these steps:

     •   Open a ContactWise email dialog in one of the following ways:

          1.  In the ContactWise main screen, select a contact and click on the email icon (Figure 5.1).
          2.  In the ContactWise main screen, right-click on the contact; in the context menu choose Create: Email 
	   Contact (Figure 5.3).
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          3.  From a Contact Display select Send Mail from the Mail menu (Figure 5.4).

Figure 5.4

Figure 5.3

     •   An Email Dialog will pop up asking if you want to use the ContactWise Email dialog or the GroupWise 
          Email dialog. This dialog will not come up if you have previously checked the box which says, “Please do 
          not display this message again” or if you have turned it off in Options.
     •   Click on the Address Book button to open the ContactWise Address Book (Figure 5.5).
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Figure 5.5

     •   Select the contact or multi-select the contacts to which you want to send a copy of the Email message, 
          then click the To, CC, or BCC button. Alternatively, you can right click on one of the selected Contacts
          and, in the context menu, choose To, CC, or BCC. Either of these will add the contact or contacts to the 
          mailing list (Figure 5.6).

Figure 5.6

     •   Click OK when all of the recipient contacts have been selected.
     •   Enter the subject and body of your email and click the Send button.
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   5.2.1 Email to Multiple Contact Addresses
   NOTE: This topic only applies when GroupWise is being used as the collaboration client.

        •   Open up the ContactWise Email dialog to write an email message to the respective contact.
        •   Open the Address Book by clicking on the button in the upper right corner (Figure 5.5).
        •   Click the To button at the top and double-click on the name of the contact that the message will be sent
             to (Figure 5.6).
        •   One by one, select each email address you want the message to be sent to.
        •   When all of the addresses have been selected, click OK and return to the ContactWise Email window.

   5.2.2 Opening the ContactWise Address Book
   NOTE: This topic only applies when GroupWise is being used as the collaboration client.

        1.  Follow the steps in section 5.1 to open the ContactWise Email dialog.
        2.  In the email message window click the Address Book button (Figure 5.5). From here you can select the
	 recipients for you message.

5.3 Adding Multiple Email Addresses
To add a new email address from within a contact record, do the following:

     •   Open the contact record (Figure 5.7).
     •   If the contact already has one or more addresses, select an address description from the pane on the left 
          side of the contact display. If the contact does not have any addresses, an address can be added in the
          same way it is added during a Full Add.
     •   In the Email field, enter the email address.

Figure 5.7

There are several ways to add additional email addresses for a contact or company:

     1.  Find and highlight the contact or organization in the ContactWise main screen.

          •   Right-click on the selected contact and select Add from the context menu
          •   Select New Email Address from the sub-menu (Figure 5.8)
          •   Type in the description and email address
          •   Check Set to Primary Email Address to set this as the Primary Email Address if desired
          •   Click the Save button
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Figure 5.8

     2.  While in the ContactWise Address Book, find and highlight the contact/company to which you want to
          add an additional email address. NOTE: the ContactWise Address Book is only available when Group-
          Wise is used as the collaboration client.

          •   Right-click on the contact and select Add New Email Address
          •   Type in the description and email address
          •   Check Set to Primary Email Address if desired
          •   Click the Save button

5.4 Mass Emailer
The Mass Emailer simplifies the process of sending a personalized email to groups of contacts. The Mass 
Emailer includes the following features:

     •   Allows data from contact records to be merged into the email
     •   Allows attachments to be included with the email
     •   Allows the email to be sent as both plain text and as HTML
     •   Allows a history note to be created for each email recipient
     •   Allows email to be sent through GroupWise or thought an SMTP server

The Mass Emailer can be accessed in any of the following ways:

     •   Run a Quick Filter in the main screen of ContactWise and choose Mass Email result list from the action 
          list found just above and to the right of the grid where the results are displayed (Figure 5.9).
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Figure 5.9

     •   Using the control key, multi-select several contacts in the ContactWise main grid and choose Mass Email  
          Selected Contact(s) from the Tools menu (Figure 5.10).

Figure 5.10

     •   When in the Groups and Filters tab of the main screen in ContactWise, select a group and choose Mass 
Email Group/Filter from the Tools menu (Figure 5.11).

Figure 5.11
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Once the Mass Emailer has been accessed (Figure 5.12), an email can be sent using the following steps:

     1.  Fill out the fields at the top of the Mass Emailer.
     2.  If you have an attachment to include, click on the folder icon to the top right of the Attachments box,
          browse to the desired file, select it, and click the Open button.
     3.  Type the body of the message. Whenever you want to include a ContactWise field in the message,
          simply double-click on the desired field in the list on the left hand side of the Mass Mailer. This will allow
          data from the ContactWise contacts to be merged with the email.
     4.  If you have an HTML Message to include, click on the folder icon to the right of the HTML Message box, 
          browse to the HTML file, select the file and click the Open button.
     5.  If you wish to receive a return receipt from the email recipients, click the box marked Request a return 
          receipt.
     6.  If you wish to have a history note added to each of the recipients then check the box marked Create a 
          History Note for the merged Emails.
     7.  You may send out test copies of your email by clicking on the Test Email button.
     8.  Click the Send Email button.

The email will be sent through GroupWise or through SMTP server depending on your settings in ContactWise 
options.

Figure 5.12

5.5 Outlook Email Import
ContactWise allows email to be imported from Outlook into ContactWise. Importing email results in a history 
item being created for that email in the appropriate contact record. If the email address does not exist in
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ContactWise then, depending on importing options chosen, a new record can be automatically created and the 
email is imported to the new record. Attachments are not imported.

     •   Outgoing Email: If the email is outgoing, ContactWise looks at the email address of the recipient(s). If 
          exactly one contact in ContactWise has that email address, the email is imported.
     •   Incoming Email: If the email address is incoming, ContactWise uses the sender’s email address to deter-
          mine which contact in ContactWise should have the history item.

   5.5.1 ContactWise Collaboration Options
   Any email item, whether they reside in the Inbox folder, Sent folder, or other personal folders, can be import-
   ed into ContactWise. You must make your selection of e-mails that you would like imported from Outlook
   (usually the Inbox) prior to choosing an import option from the ContactWise button menu. The exception to
   this is to set up your collaboration options (Figure 5.13).

Figure 5.13

   The first set of choices asks you how an “outgoing” email message should be handled by ContactWise (Figure 
   5.14).

Figure 5.14

        •   Clicking the Always add them to ContactWise radio button will automatically add all outgoing e-mails to
	 ContactWise, respecting the rule of the 2nd option set.
        •   The Prompt me each time BEFORE sending an e-mail option is used by default. When selecting and im-
	 porting an e-mail, a dialog box will appear asking if you would like to save your sent message to Con-
	 tactWise. There is also a checkbox option allowing you to NOT display the prompt message again. If
	 this is checked, the Options menu will appear allowing you to change the way your outgoing email will
	 be imported in the future.
        •   When using the Never add them to ContactWise option, you may send outgoing e-mail messages with-
	 out ContactWise intervention.

   Adding selected email messages to ContactWise affects both outgoing and incoming email messages (Figure
   5.15).
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Figure 5.15

        •   Using the Automatically add selected e-mail messages to ContactWise option can automatically create
	 a new contact depending on the option chosen (Figure 5.16). A new contact will be created with the
	 sender’s e-mail address allowing ContactWise to automatically import the e-mail into the contact’s His-
	 tory tab. The option is only valid when you are automatically adding selected e-mail messages to Con-
	 tactWise. It is disabled if you are manually choosing from a list of Contacts to add selected e-mails.
        •   If the Manually choose from a list of Contacts to add selected e-mails option is chosen, a dialog box
	 will appear allowing you to perform a number of options to manually choose a contact to have an email
	 imported.

Figure 5.16

        •   When you select the Automatically create contacts radio button, a contact is created automatically
	 without prompting.
        •   If you select the Prompt me before a new contact is created radio button, you will be prompted before
	 any contact is created in ContactWise. With this option, you can decide whether to have the contact
	 created or not.

   ContactWise will not import an email addres if it already exists for multiple contacts. Instead, it will display a 
   message indicating that the email was not imported and create a log file.

   5.5.2 Add Selected Email to ContactWise
   Imports selected Outlook e-mail into contacts either existing, or created depending on options, into the His-
   tory tab of the contact. For further information, see the GroupWise import to contacts dialog box, which
   operates identical.

   5.5.3 Add Selected Email to Opportunity
   This is always a manual function. A dialog box is displayed showing a list of Contacts or Companies linked
   with an Opportunity template. Selected Outlook e-mails are loaded into the form after which they can be
   saved to the opportunities that you choose. As you save the imported e-mails, contacts are created depend-
   ing on the options you choose and stored to the the History Tab. Additionally, the e-mails are also stored to
   the Opportunity History which by nature of ContactWise operation also automatically creates an email his-
   tory in the Opportunity’s History tab. For further information, see the GroupWise import to opportunities
   dialog box, which operates almost identical.



Chapter 6:  Document Merge Utility
The Document Merge Utility allows reports to be saved in either Microsoft Word (97, 2000, 2003) or WordPer-
fect (8-2002) documents that update themselves every time they are opened. It is an effective tool for up-to-
date documentation as well as report production.

6.1 Creating a Merge Document

     1.  Open the Document Merge Utility dialog (Figure 6.1) in one of the following ways:

          a.  After selecting a record from the main grid in ContactWise, go to the Tools menu and select Document
	   Merge Utility.
          b.  Right-click on a contact in the main grid and select Print-Document Merge Utility from the context
	   menu.
          c.  Open a group and select Document Merge Utility from the Print menu.
          d.  Open a filter and select Document Merge Utility from the Print menu.

Figure 6.1

     2.  Once the Document Merge Utility dialog is open, click on File and New Document. This will bring up a
dialog form which you can select a word processor (Figure 6.2).

Figure 6.2

     3.  Choose a word processor that you have installed on your computer and click OK. This will bring up a
          Save As dialog.
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          Now a document can be typed using your word processor, inserting ContactWise field IDs where neces-
          sary.

When opened at a later time, the Merged Document will populate with the desired fields from the Contact-
Wise database.

Note that if a Merge Document includes property tab fields, a new Merge Document will have to be created 
in the other database for it to function correctly. If it does not inclue property tab fields, the Document can be 
opened with any database.

6.2 Editing a Merge Document

     1.  Open the Document Merge Utility dialog using the directions in Step 1 of the previous section.
     2.  Once the Document Merge Utility dialog is open, select the document you wish to edit, then click File
          and Edit Document (Figure 6.4). This will open the document in the appropriate word processor and the
          List of Available Fields dialog. Note that the document to be openend should not already be running in
          another program. If it is running, close it and allow the Document Mergy Utility to open it.

     4.  Name the document and click Save. This will open the document in the Word Processor you chose in
          step 2 as well as the List of Available Fields (DMU Field List) dialog (Figure 6.3).

Figure 6.3
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Figure 6.4

     3.  Make the necessary changes, inserting ContactWise field ID’s where needed

6.3 Launching a Merge Document

     1.  Open the Document Merge Utility using the directions in Step 1 of Section 6.1
     2.  Select the Document you wish to Launch and click the Launch button (Figure 6.5)

Figure 6.5

          •   If the selected document is already open when it is launched, the Document Merge Utility will open a
	   Read-Only version of the document. If the document is not already open, it will not be Read-Only in
	   the Document Merge Utility version.

     3.  If you want to keep the original Merge Document, use Save As when saving the new merged document.
          Note that if you use the same name as you listed in the Document Merge Utility, it will no longer be avail-
          able for future document merges.

   6.3.1 Using Merge Document with Multiple Databases

        •   Any Merge Document, which does not include property tab fields, can be used with any database.
        •   If a particular Merge Document does include property tab fields, a new Merge Document will have to 
	 be created in the other database for it to function correctly.
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6.4 ContactWise Fields Included in a Merge Document
Basic information from a Contact in ContactWise can be included in a Merge Document. When the document 
is opened, a DMU Field List will pop up with the Word Processor Screen (Figure 6.3).

To insert a ContactWise field into a merge document, either select the desired field from the List of Available 
Fields (DMU Field List) and click Add Field or simply double-click the desired field from the list.

Note that any property that is defined in your database can be used in a Merge Document. The following are 
examples of regularly used properties.

   6.4.1 Basic Information
   The basic information that can be included in a Merge Document from a record includes:

        •   First Name
        •   Middle Name
        •   Last Name
        •   Salutation
        •   Gender
        •   Generational Qualifier
        •  Organization Name

   6.4.2 Telephone Information
   The telephone information that can be included is:

        •   The primary phone number for a record – if there is not a primary phone number, the first non-primary
	 phone number will be used in the merge.
        •   The primary fax number for a record – if there is no primary fax number, no fax number will be used in
	 the merge.

   6.4.3 Address Information
   Any fields from the primary address can be included as well. If there is no primary address, the first address
   in the record will be used for the merge. The address fields are:

        •   Address
        •   City
        •   State
        •   Postal Code
        •   Country
        •   Email
        •   Web Site

6.5 Document Merge Utility Labels
Labels can be created with the Document Merge Utility using the following steps:

     •   Create a Merge Document and insert the appropriate fields for the label
     •   If you are using WordPerfect, use the following steps:

          1.  While the Merge Document is still open, choose Labels from the Format menu and select the desired
	   label settings.
          2.  Save the changes and close WordPerfect.
          3.  Launch the Merge Document from within ContactWise.

37



     •   If you are using Microsoft Word, follow these steps:

          1.  If the Merge Document has not already been saved and closed, do so now.
          2.  Launch the merge document from within ContactWise.
          3.  After the Merge is complete, insert “Merge Records*” without the quotation marks, at the top of the
	   document.
          4.  Select Replace from the Edit menu.
          5.  Click the More button to see additional options in the Find and Replace dialog.
          6.  Click the button labeled Special and select Paragraph Mark. Click the Special button again and
	   select Manual Page Break.
          7.  Type “*” without the quotation marks, in the Replace with box.
          8.  Click Replace All.
          9.  Microsoft Word should give you a message indicating that it has made the replacements. Click OK.
        10.  Using the Save As option in the File menu, save this document with a different name than your origi-
	   nal Merge Document.
        11.  Create a new document in Microsoft Word by selecting New from the File menu. In the dialog box
	   that comes up, select Blank Document and click OK.
        12.  In this new document, select Mail Merge from the Tools menu. This will bring up the Mail Merge
	   Helper dialog. There are three steps in this dialog:

               o   Select Mailing Labels from the Create drop-down menu, then click the Active Window button
	        in the dialog that comes up
	   o   Select Open Data Sources from the Get Data drop-down menu. This will open the Open Data
	        Source dialog. Browse to the file that you saved in step 10, select it, and click Open. This will
	        bring up the Header Record Delimiters dialog. Choose (none) for the Field Delimiter and the
	        asterisk symbol (*) for the Record Delimiter and then click OK. In the dialog that comes up
	        next, click Set Up Main Document. This will bring up the Label Options dialog. Select the ap-
	        propriate label options and click OK. This will bring up the Create Labels dialog. Click Insert
	        Merge Fields and select Merge Records. Click OK.
	   o   Click Merge, select New Document from the Merge to drop-down box, and click Merge again.

6.6 Creating History Notes using the Document Merge Utility
The Document Merge Utility can create a history item in each record used in a merge. The history item will 
include the following information:

     •   Name of the Merge Document
     •   Date and time of the merge
     •   User entered Subject
     •   User entered Note

To create a History Note, follow these steps:

     •   Open the Document Merge Utility dialog and check the box labeled, “Create a History Note for Contact/
          Group/Filter”
     •   Launch a Merge Document
     •   When the merge is complete, a History Note dialog will appear. In this dialog, type the desired subject
          and note. The following information will be included in the body of the note automatically:

          o   The date and time of the merge
          o   The name of the Merge Document
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6.7 Blank Fields in the Document Merge Utility
Upon completing a merge, the Document Merge Utility will display a list of contacts whose records contain one 
or more blank merge fields (Figure 6.6). The records of these contacts can be opened directly from the list and 
corrected by clicking on the contact and clicking Open Record. 

Figure 6.6
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Chapter 7: Calendar Integration
ContactWise has the ability to integrate with both GroupWise and Outlook clients. This chapter will discuss 
both, beginning with GroupWise integration.

7.1 Calendar Integration Options
Many of the calendar integration options can be accessed through one of three ways:

     •   Create sub-menu
     •   Events menu
     •   Calendar icon

   7.1.1 Create Sub-Menu
   To access the Create sub-menu, highlight your selected Contact, right-click on the name and select the Create
   option from the menu (Figure 7.1).

Figure 7.1
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   The different options in this sub-menu will be discussed later in the chapter.

   7.1.2 Events Menu
   The Events menu is located at the top of the ContactWise screen (Figure 7.2) and contains options similar to
   the Create sub-menu.



Figure 7.2

   The options in the Events menu will be discussed later in the chapter.

   7.1.3 Calendar Icon
   The Calendar icon options are the same as the options in the Events menu. To access the Calendar options,
   click on the Calendar icon  at the top of the ContactWise screen. This icon with the same options can also
   be found in the Events tab of any Contact display (Figure 7.3).

Figure 7.3
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7.2 Schedule a Task in ContactWise
ContactWise allows users to post tasks to the collaboration calendar. Follow the steps below to schedule a task 
through ContactWise.

     •   Select Schedule a Task from any one of the menus mentioned in the previous section
     •   Fill out the information in the Schedule a Task dialog (Figure 7.4)

Figure 7.4

     •   After filling out the information, click the Post button at the bottom of the window to post the task in the
          selected Contact’s GroupWise Tasklist

7.3 Schedule a Call Back
To schedule a Call Back for a Contact, use the following steps:

     •   Select Schedule a Call Back from any one of the menus mentioned in section 7.1 or any of the following:

          o   The menu that appears under the Phone icon  in the ContactWise screen
          o   The menu that appears under the Phone icon in the Phone & Address tab of a Contact display
          o   The Phone menu at the top of a Contact display

     •   Fill out the information in the Schedule a Call Back dialog (Figure 7.5)
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Figure 7.5

     •   After filling out the information, click the Post button at the bottom of the window to post the call back
          in your GroupWise Calendar

7.4 Schedule an Appointment
To schedule an appointment for a Contact, use the following steps:

     •   Select Schedule an Appointment from any one of the menus mentioned in section 7.1
     •   Fill out the information in the Schedule an Appointment dialog (Figure 7.6)

Figure 7.6

     •   After filling out the information, click the Post button at the bottom of the window to post the appoint-
          ment in the Contact’s GroupWise Calendar
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7.5 Assign a Task (GroupWise collaboration only)
ContactWise alows users to assign tasks to other people. When a task is assigned, the task is sent to both the 
person who assigned it and to each of the recipients who are assigned and is automatically posted to the re-
cipients’ tasklist. After a task is assigned, the recipients cannot modify the task.

Follow these steps to assign a task:

     •   Select Assign a Task from any one of the menus mentioned in section 7.1
     •   Fill out the information in the Assign a Task dialog (Figure 7.7) including choosing a Recipient (required)

Figure 7.7

     •   After filling out the information, click the Send button at the bottom of the window to send the task to
          the recipient(s) and post it in their GroupWise Tasklist

7.6 Assign a Call Back (GroupWise collaboration only)
ContactWise allows the user to assign a call back to another GroupWise user so the assigned user can view the 
task in the GroupWise Calendar.

To assign a call back, follow these steps:

     •   Select Assign a Call Back from any one of the menus mentioned in section 7.1 or any of the following:

          o   The menu that appears under the Phone icon  in the ContactWise screen
          o   The menu that appears under the Phone icon in the Phone & Address tab of a Contact display
          o   The Phone menu at the top of a Contact display

     •   Fill out the information in the Assign a Call Back dialog (Figure 7.8) including choosing a Recipient
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Figure 7.8

     •   After filling out the information, click the Send button at the bottom of the window to send the Call Back
          to the recipient(s) and post it in their GroupWise Tasklist

7.7 Create a Note/Reminder
The following steps will allow you to create a Note/Reminder for yourself in ContactWise:

     •   Select Note/Reminder from Events menu mentioned in section 7.1, the Calendar icon on the Contact-
          Wise main screen, or from the Calendar icon under the Events tab of the Contact record
     •   Fill out the information in the Note/Reminder dialog (Figure 7.9)

Figure 7.9

     •   After filling out the information, click the Post button at the bottom of the window to post the note/re-
          minder in your GroupWise Calendar
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7.8 Link Contact Information with an Event (GroupWise collaboration only)
Linking contact information to an event allows the contact record to be viewed when the event is reviewed or 
completed.

To link Contact information with and event, create a new Calendar Event. The current Contact will be linked to 
that event and the event will appear in the Contact’s Events tab.

While an Event dialog box is open (Figure 7.10), the following three menu items are available from the Contact 
Info drop-down menu:

Figure 7.10

     •   View Selected Record shows the record of the linked Contact
     •   Select New Contact allows a different contact to be selected as the link with the event showing up in the
          Events tab of the new linked Contact
     •   Remove Contact Link removes the Contact Link from the event – doing this before the event is initially
          posted or sent will post the event only on the GroupWise calendar and not on the Events tab of a contact

7.9 Complete Calls (GroupWise collaboration only)
Completing a scheduled or assigned call can be done following these steps:

     •   Open the Call Back to be completed – this can be done from within ContactWise or from within Group
          Wise

          o   ContactWise: Open the contact with whom the Call Back is associated, click on the Events tab, and
	   open the Call Back to be completed by double-clicking on it
          o   GroupWise: Go to the calendar, find the Call Back, and open it by double-clicking on it – when opening
	   the Call Back from within GroupWise, ContactWise must be connected to the same database to which
	   it was connected when the Call Back was originally created

     •   From the Phone menu in the bottom of the Call Back Dialog, select Place Call – this will open the Place a
Call dialog (Figure 7.11)
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Figure 7.11

Take note of the Call Result drop-down box which allows you to track whether the call was a Success, you Left a 
Message, got a Busy Signal, or there was No Answer.

7.10 Outlook Integration
ContactWise allows items to be placed on the Outlook calendar. To do this, open a contact to the Events tab, 
click on the calendar icon , and choose one of the following menu items:

     •   Schedule a Task
     •   Schedule a Call Back
     •   Schedule an Appointment
     •   Assign a Task
     •   Assign a Call Back
     •   Assign an Appointment
     •   Note/Reminder

When any of these items are chosen then the appropriate outlook dialog comes up (Figure 7.12). Fill out the 
dialog as would normally be done if the dialog had been opened directly from outlook. By initiating one of the 
above items from ContactWise that item will not only appear on the Outlook calendar but on the contact’s 
events tab as well.
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Figure 7.12

The Outlook calendar can also be opened from the same menu mentioned above by choosing the Open Calen-
dar item.
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Chapter 8: Generating Reports
In this chapter you will learn how to generate reports based on your ContactWise database, including creating 
Custom Reports.

8.1 Opening the Report Writer
The reporting tool can be opened from either the ContactWise Main screen or from a Group or Filter.

   8.1.1 From the Main Screen of ContactWise
   To generate a report from the main screen in ContactWise (Figure 8.1), follow these steps:

        •   Select or multi-select a group of contacts
        •   From the Reports menu select Generate Report For Selected Contacts/Opportunities

Figure 8.1

   8.1.2 From a Group or a Filter
   To generate a report from a Group or a Filter, follow these steps:

        •   Go to the Groups and Filters tab on the main screen of ContactWise (Figure 8.2)

Figure 8.2
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     •   Double-click on a Group or a Filter to open it
     •   From within the Group or Filter do ONE of the following

          1.  From the Print menu select Entire Group or Entire Filter, depending on what you chose
          2.  Select one or more Contacts and choose Selected Contact(s)

8.2 Report Explorer
After you have made your selection, the Report Explorer dialog will appear (Figure 8.3)

Figure 8.3

From this screen, you can select the information you want printed in your report. In the above example, the 
Address field on the left side of the dialog is selected giving the option to print a report based on an Address 
List by Organization in the right side of the dialog. Simply double-click the desired report to view a printable 
version (Figure 8.4).

Figure 8.4
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8.3 Create a Report from Report Explorer
To create a report, choose File, New, then Report (Figure 8.5).

Figure 8.5

After you have given your Report a name you will be taken to the Report Builder (Figure 8.6).

Figure 8.6

For additional instruction on using the Report Builder, contact GroupLink support at (801)335-0728.
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8.4 Modify an Existing Report
To modify an existing Report, right-click on the desired report in the Report Explorer dialog and select Design 
from the menu (Figure 8.7).

Figure 8.7

When modifying an existing Report, it is best to save it under a different name so you can refer back to the 
original Report as needed.

For additional instruction on modifying an existing Report, contact GroupLink Support at (801)335-0728.



Appendix
General Short Cut Keys:

     •   (Select Contact) + Shift + Page Down: Select all contacts below highlighted contact on the same page.
     •   (Select Contact) + Shift + End: Select all contacts below highlighted contact

Short Cut for the ContactWise Main Window:

     •   Ctrl + G: Open Groups Window
     •   Ctrl + Alt + G: Go Remote
     •   Ctrl + I: Current database information
     •   Ctrl + Alt + M: Document Merge Utility
     •   Ctrl + N: Edit Comments
     •   Ctrl + M: Email Contact
     •   Ctrl + O: Open Database
     •   Ctrl + P: Print
     •   Ctrl + Q: Create Advance Filter
     •   Ctrl + S: Opens the Options screen
     •   Ctrl + Y: Synchronize Go Remote
     •   F1: Help
     •   F4: Bookmarks
     •   F5: Refresh Window
     •   F9: GroupWise Address Book Add/Update
     •   Ctrl + Alt + P: Create Phone / Address Filter
     •   Ctrl + U: Saves the filter as a public filter
     •   Ctrl + R: Saves the filter as a private filter
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